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Introduction to RPM–1

The Nokia RPM-1 is a dualband PC card transceiver designed for opera-
tion in GSM900, GSM1800 and GSM900/GSM1800 dualband networks. It
supports the high–speed circuit switched data service (HSCSD) which of-
fers data rates up to 43.2 kbps by using multiple receive and transmit time
slots.

The RPM-1 does not have a battery or user interface of its own. Instead,
the device is powered and controlled through the standard 68–pin
PCMCIA connector.  Physically and electrically the RPM-1 is compatible
with the PC Card Standard (type II extended card).

The antenna element is of PCB type. The antenna can be removed and
same connector used for connecting an external antenna cable.

The SIM ( Subscriber Identity Module ) card slot is located on the side of
the RPM-1 as shown in the figure below.

Audio (voice) services are available through an analog headset.

RPM-1 Product

Antenna

SIM card slot

Hole to remove the SIM

PCMCIA connector

Headset connector

Item Name: Type code: Material code:

1. Transceiver RPM-1 0630181
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Product and Module List

Name of module Type code Material
code

Notes

Transceiver RPM–1 0630181 No SIM lock or Colabel in basic transceiver

RF/BB module GX9 0201215 Not for sale as a spare part

Assembly parts MRPM1 0261772 Assembly parts must be ordered as separate
spare parts

CMT SW module SW 0240605
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Technical Specifications

Mechanical Characteristics

Unit Dimensions
(mm) 

(W x H x D)

Weig
ht 
(g)

Vol-
ume
(cc3)

Notes

 RPM–1 module (including antenna) 124 x 54 x 10 58 36

 Radio/System module GX9 106.1 x 51

User Interface Features

All user interface functionality is contained in the software application run-
ning in the host computer.

Environmental Conditions

Temperature Conditions

Parameter Ambient temperature
(degrees Celsius)

Notes

Max operation temperature range –10 to +55

Storage temperature –25 to +85

Vibration and Free Fall

The RPM-1 will meet the RMS phase error requirements under  0.005
g2/Hz acceleration spectral density in the range 10 Hz ... 20 Hz and 0.005
g2/Hz at 20 Hz thereafter –3 dB/octave in the range 20 Hz ... 150 Hz. This
equates to a total RMS vibration in the range 10 Hz to 150 Hz of 0.5 g.

RPM–1 will not break mechanically under a sinusoidal vibration of  2 ...
200 Hz, 2.0  g or after free fall from 75 cm height to concrete floor.

Humidity and Water Resistance

Relative humidity range in normal operation conditions: 20 ... 75 %.

Relative humidity range allowed: 5 ... 95 %, non–condensing.

RPM–1 is not protected against ingress of water. RPM–1 may be instan-
taneously subjected to dripped or condensed water. Longer term contact
with water will cause permanent damage.

Warnings and Restrictions

When operating the RPM-1 the antenna should be kept in vertical posi-
tion.
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Introduction to Installation
This guide describes how to install the Nokia RPM-1 Phone software on a
PC and how to start using it. For more detailed information, consult the
RPM-1 Phone Online Help.

Contents of the sales package
In the sales package, you should find the following items:

•  RPM-1 Phone, an integrated PC Card and mobile transceiver

•  CD–ROM containing the software, including the Online Help

•  protective case for the RPM-1phone

•  Installation Guide

The license agreement is included in the Setup program and in the Online
Help of the Nokia RPM-1Phone.

System requirements

The Nokia RPM-1 Phone requires:

•  Intel compatible PC that runs Windows 95/98 or Windows NT 4.0 with service
pack 3 or newer

•  PC Card type II or III extension slot

•  at least 15 MB of free disk space

Network services

Some of the features supported by the RPM-1 are network services. Be-
fore you can benefit from these services, you must subscribe to them
from your service provider and obtain instructions on their use.

Services that need to be subscribed to are typically the Short Message
Service (SMS), data service and fax service. Some service providers may
not provide all communications services.

Contact your service provider for further information about the availability
and details of the services in your home network.

To access the Internet, you must have subscribed to the data service from
your service provider and obtained an Internet access point from an Inter-
net service provider.

Communications software

To connect to the Internet, or to send and receive e–mail or faxes, or
transmit data from your computer, you need the appropriate data and fax
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communications software. You can use the RPM-1 with most commercial-
ly available communications applications, such as Microsoft Exchange,
Microsoft Outlook and Netscape Navigator.  Windows 95/98/NT4.0 in-
clude several communications applications, such as Dial–Up Networking
and HyperTerminal.

For more information on data and fax communications, see the “Getting
Started” section.

Installation
This section provides step–by–step instructions on how to install the
RPM-1 software on your PC.

Note: There are some slight differences in the installation process be-
tween Windows 95/98 and Windows NT. If the installation differs from the
steps described in this section, follow the instructions on the screen.

lf you want to quit the Setup program without installing or uninstalling, just
click Cancel and the Exit Setup window will offer you the possibility of
quitting the Setup program. Click Exit Setup to quit Setup. lf you want to
rerun the Setup program after having quit the installation before it was
completed, follow the installation steps normally as if you were installing
the program for the first time.

Note: Please DO NOT INSERT the Nokia RPM-1 into the PC card slot of
your computer until the Installation Program asks for it.

First installation steps

1 Exit all Windows programs.

2 Remove all other PCMCIA cards from the PC card slot.

3 Insert the CD–ROM into the CD–ROM drive. The Setup program should

start automatically. If not, follow the steps below.

4 Click the Windows START button.

5 Select the Run command.

6 The Run dialog box appears on the screen. Type in the following

command line: D:\SETUP

In the above command line, “D:\” is the CD–ROM drive.

7 Click OK or press Enter. Wait while the system initializes the Setup

program. Next, the Welcome window of the Setup is displayed.

8 Click Next to continue with the Setup program.

Phone Power–up Warning

The RPM-1 will be switched on during Setup. This is not allowed in some
environments, such as hospitals and aeroplanes. To continue with Setup,
click Continue .
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WARNING!

Do not switch on the phone when wireless phone use is prohibited or
when it may cause interference or danger.

Additional window (Windows 95 only)

If the PC RPM-1 Modem Power Management window appears, you are
being asked to disable the PC RPM-1 Modem Power Management selec-
tion in the Windows 95 settings. You must disable the selection in order to
be able to install and use the RPM-1. Click Yes to cancel the selection.

Software Licence Agreement

You must read through and accept the Nokia Mobile Phones Licence
Agreement before you can continue with the installation. If you do not ac-
cept the Licence Agreement, you cannot use the program and Setup will
stop the installation of the program. Select the language of the agreement
from the drop–down list box. Click Yes to accept the Licence Agreement.

Setup Type

There are three types of setups available, depending on which compo-
nents you want to install:

Typical

•  installs the RPM-1 and two languages: English and the current Windows
language if available.

Compact

•  installs the  RPM-1 and the English language.

Custom

•  installs the selected components. In the Select Components window,se-
lect the applications you want to install.

Screenshot of the setup window is below.

To install additional languages, click the Languages button, and in the
Select Languages window select the languages you want to install. Click
Continue . Finally, click Next .

The Setup program suggests C:\Program Files\Nokia as the default
installation directory. lf you want to install the program in another drive or
directory click Browse .
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The program places some files in your Windows directory and automati-
cally installs and configures the Windows modem settings.

The program itself requires 10 MB of disk space, but during installation
the Setup program needs approximately 15 MB of disk space. If this is
acceptable, click Next to start the installation.

Start Copying Files

The Start Copying Files window displays the current settings. Click Next
to proceed and Back to change the settings.

RPM-1 Phone Driver Settings (Windows NT 4.0 only)

If your PC runs Windows NT 4.0, the Setup program now checks the
RPM-1 driver settings. Do not change the suggested settings unless you
know that they conflict with the existing hardware. Click OK to continue.

User Information

In this window, you can enter your user information. Click Next to pro-
ceed.

Insert RPM-1 Phone 2.0

Please insert the RPM-1 into the PC card slot. Under Windows NT 4.0,
click OK. Under Windows 95/98, wait until Setup locates the RPM-1.

Driver Installation Check  (Windows 95/98)

This window appears automatically after the Setup program has located
the RPM-1. Setup now checks the driver functionality, Windows Tele-
phone Application Interface (TAPI) and Mobile Phone Application Inter-
face (MPAPI). If the item passed the test, OK appears next to the tested
item. In case of a failure, Failed! is shown. Click Retest to rerun the test
or Next to continue.

If some items failed their test, refer to the Troubleshooting section for pos-
sible solutions.

Setup Complete

The installation has been completed. Select Yes, I want to restart my
computer now to restart your computer and click Finish.

Note: Under Windows NT 4.0, the Driver Installation Check window ap-
pears after you have restarted your computer upon completion of the
installation.

Please read the README file, included in the RPM-1 Phone Program
Group, for the latest information about the product. This file is provided in
English.
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Modifying the RPM-1 Setup

If you want to modify the RPM-1 setup, by installing more languages for
example, start by following the instructions given in the “First installation
steps” section at the beginning of the previous main section.

After the system has initialized Setup, the Nokia Card Phone 2.0 Setup
window is displayed. You can choose one of the following options:

•  Add/Remove

Select this option to install or uninstall components. In the Select Compo-
nents window, select the components that you want to install, and clear
the components you do not want to install. To install or uninstall lan-
guages, click the Languages button.

•  Reinstall

Select this option to reinstall all the program files. This reinstallation re-
peats the previous setup. Reinstallation is needed when some of the files
have been corrupted.

•  Check Installation

Select this option to check the existing  RPM-1 installation and driver
functionality.

•  Remove All

Select this option to uninstall the RPM-1 program files and drivers.

Finally, click Next .
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Getting started

Starting the RPM-1
Note: If you are running Windows NT 4.0, insert the Nokia RPM-1 into the
PC card slot before you turn on the computer.

Slide the SIM card into the SIM card slot of the RPM-1 and insert the
RPM-1  into the PC card slot of your computer. The RPM-1 program
starts automatically when the RPM-1 is inserted. You may have to enter
the PIN (Personal Identity Number) code if the PIN code request is acti-
vated in the SIM card.

The PIN code is usually supplied with the SIM card. If you enter an incor-
rect PIN code three times in a row, you will need a PUK (Personal Un-
blocking Key) code to unblock the SIM card.

The PUK code may be supplied with the SIM card. If not, contact your
service provider.

Using the RPM-1
The RPM-1 is automatically switched on when you insert it in the PC card
slot of your computer. The RPM-1 program consists of five applications:
Contacts, Messages, Dialler, Call Register and Settings. To open an ap-
plication, click the application icon you want in the left–hand icon bar.

You can view the status of the RPM-1 in a separate Monitor window. To
open the Monitor window, click the Go menu and then click Monitor . To
exit the RPM-1 program, remove the RPM-1 from the PC card slot and
select the Exit command from the File menu.

Detailed information on how to use the RPM-1 is available as an Online
Help. To open Help, click the Help menu or Help buttons in the RPM-1
windows.

Text messages

The Short Message Service (SMS) is a network service that enables you
to send and receive short text messages over the digital cellular network.

Messages can be read on any mobile phone that has SMS capability.

The sending and receiving of text messages requires that the Short Mes-
sage Service (SMS) be available in the network you are using and acti-
vated for your SIM card. Contact your service provider for details.

Before you can send text messages, you must store the SMS message
centre number in the Settings window, Messages tab.

Voice calls

It is possible to make voice calls from your PC with the Headset HDC–6D
which is available as an accessory.
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Data and fax communication

The RPM-1 provides the functionality of a cellular modem. To send and
receive e–mail and faxes, connect to remote computers and access the
Internet, you also need the appropriate data and fax communications
software. You can use the RPM-1 with a variety of commercially available
Windows 95/98/NT 4.0 compatible data and fax communications applica-
tions. These applications must be correctly configured for use with the
RPM-1, according to the instructions given in the documentation of these
applications and your computer. Remember to select the RPM-1  as the
modem in each application. The data transfer and fax functions depend
on the applications you have chosen, not on the computer or the RPM-1.
For information on how to use an application, please refer to that applica-
tion’s documentation.

The RPM-1 supports three PC Fax standards: EIA/TIA Class 1, Class 2
and Class 2.0. lf you have problems with using the RPM-1 for fax trans-
missions, make suret hat the remote end fax machine is Group 3 compat-
ible.

The RPM-1 can also be controlled with AT Commands. For more informa-
tion, refer to the RPM-1 AT Command Help, included in the RPM-1 Pro-
gram Group

High Speed Circuit Switched Data (HSCSD)

The RPM-1 supports High Speed Circuit Switched Data (HSCSD) which
enables a data transmission speed that is more than four times higher
than the standard speed of 9.6 kilobits per second. HSCSD technology is
based on the use of multiple timeslots at the same time. In the RPM-1,
the data transmission speed in a single timeslot is 9.6 or 14.4 Kbps, de-
pending on the network. When sending and receiving e–mail, the 14.4
Kbps data transmission speed can be doubled up to 28.8 Kbps , and
when downloading Web pages, the RPM-1 is able to triple the transmis-
sion speed to 43.2 Kbps.

You can change the HSCSD settings of your RPM-1 in the Settings win-
dow, Modem tab. The use of these settings requires that your home net-
work supports HSCSD technology and that you have subscribed to this
service. Contact your service provider for more information.

Dual–band Functionality

When you are travelling, dual– band functionality gives you more roaming
possibilities, depending on your network operator’s roaming agreement.

Electrostatic Discharge (ESD)

A discharge of static electricity from a finger or a conductor may cause
errors in the function of electric devices. The discharge can result in a
“garbled” display and unstable software operation. Cellular connections
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may become unreliable, data may be corrupted, and the transmission
may be halted. In this case you need to end the existing call (if any), and
exit the RPM-1Phone program.

Charge in computer batteries

The RPM-1 does not have its own internal battery. Instead, it uses the
computer battery as its power source.

lt is possible to charge the computer battery while the RPM-1 is in use.
For more information on charging the computer battery, refer to the docu-
mentation of the computer.

The power consumption of the phone is approximately the same for data/
fax calls as it is for voice calls of the same length.

Signal strength affecting cellular transmissions

You need to be in an area that is covered by a network to use the RPM–1
Phone.

Accessories

To make and receive voice calls with the RPM–1, the headset HDC–6D is
needed.  Kindly refer to the Accessories section of this manual.

To improve the reception and operating range of the RPM–1, the external
antenna cable XRP–2 can be used to replace the standard antenna of the
phone.  Kindly refer to the Accessories section of this manual.

Troubleshooting

The RPM-1Phone cannot be installed or used.

The Interrupt Request (IRQ) resources may be in conflict. Check the
RPM-1 resources from Control Panel/System/Device Manager/Modem
RPM-1/select Properties/Resources. If there is a resource conflict, consult
the Windows online help on changing the resource settings.

If you have Windows 95 OSR#2, do not start the installation by first insert-
ing the RPM-1. If you already have done this, you may have an incorrect
modem driver selected. To change the driver, select the Control Panel/
System/Device Manager/Modems, and remove the Standard PCMCIA
modem. Then remove the RPM-1 and restart setup.exe.

In Windows NT 4.0, there may be problems when third–party RPM-1Ser-
vices are used. For example, hot swapping may not be possible. Current-
ly, the RPM-1 supports SystemSoft CardWizard and Softex RPM-1Ser-
vices.

The RPM-1 is not properly inserted. Make sure that the PC RPM-1slot of
the computer is functioning properly and that the RPM-1 driver is installed
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(in Control Panel: Modems). Also make sure that the SIM RPM-1has
been inserted.

Make sure that the RPM-1 is fully compatible with the communications
application. lf in doubt, contact your dealer.

You want to change the language of the program.

The language is changed in the Settings main view, General tab. Select
the language in the Language drop–down box and click Apply .

The languages available are those that were selected during the installa-
tion. The change takes effect after you restart the program.

The program cannot be reinstalled.

The RPM-1 program may be running. Remove the RPM-1 from the PC
RPM-1slot and exit the program by selecting the File menu and clicking
Exit, or by right–clicking the RPM-1 icon on the taskbar and then clicking
Close .

You can also remove the RPM-1 from the PC RPM-1slot and restart the
computer. After this, try again.

The network signal is weak, and you also suspect interference from
the laptop.

In addition to the regular antenna attached to the RPM-1,an external an-
tenna may be used. Attach it to the laptop, and the call quality may im-
prove.

There seems to be problems with call quality.

 Do not obstruct the antenna with anything, your hand for instance.

A data call is in progress, and this is not shown in the RPM-1
Monitor window or in the Dialler main view, Dialler tab.

This depends on the communications application that is being used.

After removing the RPM-1 and inserting it again, Windows stops
responding.

After you remove the RPM-1, wait for a while before you reinsert it.

Care and maintenance

When using your phone OR any accessory:

Keep it and all its parts and accessories out of small children’s reach.
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Keep it dry. Precipitation, humidity and liquids contain minerals that will-
corrode electronic circuits.

Do not use or store it in dusty, dirty areas. Its moving parts can be dam-
aged.

Do not store it in hot areas. High temperatures can shorten the life of
electronic devices, damage batteries, and warp or melt certain plastics.

Do not store it in cold areas. When the phone warms up (to its normal
temperature), moisture can form inside the phone, which may damage

electronic circuit boards.

Do not attempt to open it. Non–expert handling of the device may dam-
age it.

Do not drop, knock or shake it. Rough handling can break internal circuit
boards.

Do not use harsh chemicals, cleaning solvents, or strong detergents to
clean it. Wipe it with a soft cloth slightly dampened in a mild soap–and–
water solution.

Do not paint it. Paint can clog the device’s moving parts and prevent
proper operation.

Use only the supplied or an approved replacement antenna. Unautho-
rised antennas, modifications or attachments could damage the phone
and may violate regulations governing radio devices.

If the phone or any accessory is not working properly, take it to your near-
est qualified service facility. The personnel there will assist you and, if
necessary, arrange for service.
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